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This document is prepared as a user guide to install and operate Wolfspeed® evaluation hardware.  
 
All parts of this user guide are provided in English, and the Cautions are provided in English, Mandarin, and 
Japanese. If the end user of this board is not fluent in any of these languages, it is your responsibility to ensure 
that they understand the terms and conditions described in this document, including without limitation the 
hazards of and safe operating conditions for this board. 
 
本文件中的所有内容均以英文书写，“注意”部分的内容以英文、中文和日语书写。作为本板子的终端

用户，即使您不熟悉上述任何一种语言，您也应当确保正确理解本文件中的条款与条件，包括且不限于

本板子的危险隐患以及安全操作条款。 
 
当書類のすべての内容は英語で書きます。「注意点」の内容は英語、中国語、また日本語で書きます。

当ボードの端末使用者は上記の言語が一つでもわからないなら、当端末使用者は当書類の条約と条件

が理解できるのを確保すべきです。そして、当ボードの危険や安全に使用する条件を含み、また限り

ません。 

 
Note: This Wolfspeed-designed evaluation hardware for Wolfspeed components is a fragile, high-voltage, high-
temperature power electronics system that is meant to be used as an evaluation tool in a lab setting and to be 
handled and operated by highly qualified technicians or engineers. When this hardware is not in use, it should 
be stored in an area that has a storage temperature ranging from -40° Celsius to 105° Celsius.  If this hardware 
is transported, to avoid any damage to electronic components, special care should be taken during 
transportation to avoid damaging the board or its fragile components and the board should be transported 
carefully in an electrostatic discharge (ESD) bag, or with ESD or shorting protection that is the same as, or 
similar to, the protection that is or would be used by Wolfspeed when shipping this hardware.  Please contact 
Wolfspeed at https://forum.wolfspeed.com/ if you have any questions about the protection of this hardware 
during transportation.  The hardware does not contain any hazardous substances, is not designed to meet any 
industrial, technical, or safety standards or classifications, and is not a production-qualified assembly.  
 
本样机（易碎、高压、高温电力电子系统）由Wolfspeed为评估其功率半导体产品而设计，用以作为在

实验室环境下由专业的技术人员或工程师处理和使用的评估工具。本样机不使用时，应存储在-40°~105°

温度范围的区域内；如需运输样机，运输过程中应该特别小心，避免损坏电路板等易碎组件。如果您对

此硬件在运输之中的保护有任何疑问，请联系https://forum.wolfspeed.com/。 样机应放置在防静电包装

袋内谨慎运输，避免损坏电子组件。本样机不含任何有害物质，但其设计不符合任何工业、技术或安全

标准或分类，也不是可用于生产的组件。 
 
このクリーのコンポーネント用評価ハードウェアは壊れやすい高電圧の高温パワーエレクトロニクス

システムであり、ラボ環境での評価ツールとして使用され、優秀な技術者やエンジニアによって処理

され、操作されることを意図している。ハードウェアが使用されていない場合、保管温度が-40℃から

105℃の範囲に保管してください。このハードウェアを輸送する場合は、輸送中にボードまたはその壊

れやすいコンポーネントに損傷を与えないよう特別な注意を払う必要がある。また電子部品の損傷を

避けるためにボードを静電気放電（ESD）袋に静置して慎重に輸送するべき。ハードウエアの輸送中の

保護について質問があれば、https://forum.wolfspeed.com/に連絡してください。ハードウェアには危険

物質が含まれていないが、工業的、技術的、安全性の基準または分類に適合するように設計されてお

らず、生産適格組立品でもない。  

https://forum.wolfspeed.com/
https://forum.wolfspeed.com/
https://forum.wolfspeed.com/
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CAUTION 
 
PLEASE CAREFULLY REVIEW THE FOLLOWING PAGES, AS THEY CONTAIN IMPORTANT INFORMATION REGARDING THE 
HAZARDS AND SAFE OPERATING REQUIREMENTS RELATED TO THE HANDLING AND USE OF THIS BOARD. 
 
DO NOT TOUCH THE BOARD WHEN IT IS ENERGIZED AND ALLOW THE BULK CAPACITORS TO COMPLETELY DISCHARGE PRIOR 
TO HANDLING THE BOARD.  THERE CAN BE VERY HIGH VOLTAGES PRESENT ON THIS EVALUATION BOARD WHEN CONNECTED 
TO AN ELECTRICAL SOURCE, AND SOME COMPONENTS ON THIS BOARD CAN REACH TEMPERATURES ABOVE 50˚ CELSIUS.  
FURTHER, THESE CONDITIONS WILL CONTINUE FOR A SHORT TIME AFTER THE ELECTRICAL SOURCE IS DISCONNECTED 
UNTIL THE BULK CAPACITORS ARE FULLY DISCHARGED.  
 
Please ensure that appropriate safety procedures are followed when operating this board, as any of the following can 
occur if you handle or use this board without following proper safety precautions:  
 

DEATH ▲ SERIOUS INJURY ▲ ELECTROCUTION ▲ ELECTRICAL SHOCK ▲ ELECTRICAL BURNS ▲ SEVERE HEAT BURNS 
  
You must read this document in its entirety before operating this board.  It is not necessary for you to touch the board while it is 
energized.  All test and measurement probes or attachments must be attached before the board is energized.  You must never 
leave this board unattended or handle it when energized, and you must always ensure that all bulk capacitors have completely 
discharged prior to handling the board.  Do not change the devices to be tested until the board is disconnected from the electrical 
source and the bulk capacitors have fully discharged. 

警告 
请认真阅读以下内容，因为其中包含了处理和使用本板子有关的危险隐患和安全操作要求方面的重要信息。 
 
请勿在通电情况下接触板子，在操作板子前应使大容量电容器的电荷完全释放。接通电源后，该评估板上通常会存在危险
的高电压，板子上一些组件的温度可能超过 50摄氏度。此外，移除电源后，上述情况可能会短时持续，直至大容量电容器
电量完全释放。 
 
操作板子时应确保遵守正确的安全规程，否则可能会出现下列危险：  
 

死亡 ▲ 严重伤害 ▲ 触电 ▲ 电击 ▲ 电灼伤 ▲ 严重的热烧伤 
 
请在操作本板子前完整阅读本文件。通电时禁止接触板子。所有测试与测量探针或附件必须在板子通电前连接。通电时，
禁止使板子处于无人看护状态，且禁止操作板子。必须确保在操作板子前，大容量电容器已释放了所有电量。只有在切断
板子电源，且大容量电容器完全放电后，才可更换待测试器件。 

警告 
 

ボードの使用、危険の対応、そして安全に操作する要求などの大切な情報を含むので、以下の内容をよく読んでくださ
い。 
 
通電している時、ボードに接触するのは禁止です。ボードを処分する前に、大容量のコンデンサーで電力を完全に釈放
すべきです。通電してから、ボードにひどく高い電圧が存在している可能性があります。ボードのモジュールの温度は
50 度以上になるかもしれません。また、電源を切った後、上記の状況がしばらく持続する可能性がありますので、大容
量のコンデンサーで電力を完全に釈放するまで待ってください。 
 
ボードを操作するとき、正確な安全ルールを守るのを確保すべきです。さもないと、以下の危険がある可能性がありま
す: 
 

死亡 ▲ 重症 ▲ 感電 ▲ 電撃 ▲ 電気の火傷 ▲ 厳しい火傷 
 
当ボードを操作する前に、完全に当書類をよく読んでください。通電している時にボードに接触する必要がありませ
ん。通電する前に必ずすべての試験用のプローブあるいはアクセサリーをつないでください。通電している時に無人監
視やボードを操作するのは禁止です。ボードを操作する前に、大容量のコンデンサーで電力を完全に釈放するのを必ず
確保してください。ボードの電源を切った後、また大容量のコンデンサーで電力を完全に釈放した後、試験設備を取り
換えることができます。 



 

              4 
PRD-07560 REV. 1, Sept 2023 CRD25DA12N-FMC 25 kW Three-Phase Inverter User Guide 
© 2023 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed 
logo is a trademark of Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective 
owners and do not imply specific product and/or vendor endorsement, sponsorship, or association. 

CONTENTS 
1. INTRODUCTION ...................................................................................................................................................... 6 

2. DESIGN FEATURES ................................................................................................................................................. 7 

2.1 Key System Specifications ............................................................................................................................ 7 

2.2 Subsystem Functional Groups ...................................................................................................................... 8 

2.3 I/O Pinout ..................................................................................................................................................... 10 

2.3.1 Aux Power Connector Pinout ............................................................................................................ 10 

2.3.2 High Power Terminals ........................................................................................................................ 11 

2.3.3 Voltage Feedback Connector Pinout................................................................................................. 11 

2.3.4 CAN Port Pinout ................................................................................................................................. 11 

2.3.5 Resolver Connector Pinout ................................................................................................................ 12 

2.3.6 Relay Connector Pinout ..................................................................................................................... 13 

2.3.7 Spare Connector Pinout .................................................................................................................... 14 

2.3.8 Metrology ........................................................................................................................................... 15 

3. SYSTEM DESCRIPTION ......................................................................................................................................... 17 

3.1 Power Stage ................................................................................................................................................. 18 

3.2 Gate Drivers ................................................................................................................................................. 21 

3.3 Current Sensing ........................................................................................................................................... 22 

3.4 Voltage Sensing ........................................................................................................................................... 24 

3.5 NTC ............................................................................................................................................................... 26 

3.6 Position Sensing .......................................................................................................................................... 26 

3.7 Additional Circuitry ..................................................................................................................................... 28 

4. CONTROLLER AND FIRMWARE ............................................................................................................................. 30 

4.1 Microcontroller ............................................................................................................................................ 30 

4.2 Firmware ...................................................................................................................................................... 34 

4.2.1 Code Composer Studio Project ......................................................................................................... 34 

4.2.2 CAN Communication GUI ................................................................................................................... 36 

5. PERFORMANCE DATA ........................................................................................................................................... 38 

5.1 Heatsink ....................................................................................................................................................... 38 

5.2 Inductance ................................................................................................................................................... 39 

5.3 Experimental Validation .............................................................................................................................. 40 

5.3.1 Setup .................................................................................................................................................. 40 



 

              5 
PRD-07560 REV. 1, Sept 2023 CRD25DA12N-FMC 25 kW Three-Phase Inverter User Guide 
© 2023 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed 
logo is a trademark of Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective 
owners and do not imply specific product and/or vendor endorsement, sponsorship, or association. 

5.3.2 Experimental Results ......................................................................................................................... 41 

5.3.3 Thermal Safe Operating Area ............................................................................................................ 43 

5.4 Simulation ................................................................................................................................................... 44 

5.4.1 Power Stage ....................................................................................................................................... 45 

5.4.2 Controller ........................................................................................................................................... 46 

5.4.3 Load .................................................................................................................................................... 46 

5.4.4 Performance Monitor ......................................................................................................................... 47 

5.4.5 Default Parameters ............................................................................................................................ 48 

5.4.6 Validation ........................................................................................................................................... 49 

5.4.7 Efficiency Predictions ........................................................................................................................ 51 

6. MECHANICAL ASSEMBLY ...................................................................................................................................... 52 
 

 

  



 

              6 
PRD-07560 REV. 1, Sept 2023 CRD25DA12N-FMC 25 kW Three-Phase Inverter User Guide 
© 2023 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed 
logo is a trademark of Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective 
owners and do not imply specific product and/or vendor endorsement, sponsorship, or association. 

1. INTRODUCTION 
This user guide provides an overview of the Wolfspeed CRD25DA12N-FMC 25 kW three-phase inverter reference 
design including key system specifications, sub-system functional descriptions, performance test data, and 
mechanical assembly. The CRD25DA12N-FMC design was developed to provide power electronics engineers 
with a hardware evaluation platform and reference design files to support early design-in activities of the 
Wolfspeed WolfPACK™ baseplate-less power module platform. In conjunction with this user guide, the 
complete suite of reference design files including schematics, PCB layout, Gerber files, BOM, and 3D CAD files 
are available for download from the CRD25DA12N-FMC landing page on Wolfspeed’s website.  

The CRD25DA12N-FMC is a complete, easy-to-use, flexible power stage designed around the CCB021M12FM3T 
(1200 V / 21 mΩ) Wolfspeed WolfPACK six-pack power module. As demonstrated in the block diagram below, 
this design intends to provide everything needed to quickly evaluate performance out of the box while also 
providing the resources to expand its capabilities to suit target end-application needs. To this end, included on 
this single-PCB solution is DC bus capacitance with low-inductance power planes, gate drivers, current and 
voltage sensing, thermal management, and various control peripherals.  

By default, the CRD25DA12N-FMC is designed to be evaluated as a simple three-phase inverter topology, but 
the flexibility of the generic power stage makes it simple to adapt to other applications. As such, the design is 
ideal for evaluating or scaling up to higher power levels in industrial motor drives, power supplies, and 
renewable energy applications, or as the bi-directional active front end (AFE) stage for off-board electric vehicle 
(EV) fast charging. 

 

Figure 1: CRD25DA12N-FMC Block Diagram  

https://www.wolfspeed.com/products/power/reference-designs/crd25da12n-fmc/
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2. DESIGN FEATURES 
This section highlights the design features of the CRD25DA12N-FMC design including key system specifications, 
a description of the various functional circuit groups, and a general I/O pinout definition.   

2.1 Key System Specifications 

• Single CCB021M12FM3T (1200 V / 21 mΩ) Wolfspeed WolfPACK six-pack power module 
• General purpose controller with customizable firmware 
• Integrated hall-effect current measurements 
• Integrated resolver circuitry for rotational position feedback 
• Isolated substrate temperature measurement 
• Isolated CAN communication for real-time monitoring and adjustments 
• Separate turn-on and turn-off gate resistors for switching loss optimization 
• DC bus and phase voltage measurement circuitry 
• Dedicated overcurrent detection hardware 
• Spare GPIO and ADC header pins for adding custom auxiliary hardware 
• Spare LEDs for customization during testing and evaluation 
• Controllable current amplifier for operating external relays 
• Detailed characterization of the thermal solution for improved simulation predictions 
• Integrated gate measurement connectors for easy system troubleshooting and evaluation 

Table 1: CRD25DA12N-FMC Ratings 

 

 

 

 

Symbol Parameter Min. Typ. Max. Unit 

POUT Output Power — — 25 kW 

VDC DC Bus Voltage — 800 1000 
V 

VAUX Low-Power Auxiliary Voltage 10.8 12 13.2 

IAUX Low-Power Auxiliary Current — — 5 A 

IOUT Output Phase Current — — 30 ARMS 

fs Switching Frequency1 — 20 100 kHz 

Rth,ja Thermal Resistance, Junction-to-Ambient1  1.571  °C/W 

1Refer to Performance Data section for more information 
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2.2 Subsystem Functional Groups 

The figures below show the subsystem functional groups of the evaluation board from a top and side profile 
view with descriptions of each labeled subsystem given in Table 2. A full system description of each functional 
group is provided in Section 3.   

 
Figure 2: CRD25DA12N-FMC Top View 
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Figure 3: CRD25DA12N-FMC Side View 

Table 2: Subsystem Functional Group Descriptions 

Label Description 

A Input DC Voltage Terminals 

B MOSFET Gate Drivers 

C Gate Measurements 

D Current Sensors 

E Output AC Voltage Terminals 

F Phase Voltage Feedback 

G Isolated NTC Circuit 
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Label Description 

H F280039C Control Card 

I Isolated CAN Port 

J Spare ADCs and GPIOs 

K Fan Power 

L Relay Control 

M Encoder Feedback 

N +12V Input Power 

O Bulk DC-Link Capacitor 

P Heatsink + Fan Assembly 

Q CCB032M12FM3 WolfPACK Module 

2.3 I/O Pinout 

The design features a variety of ports for connecting external sensors, controlling external hardware, and 
communicating directly with the onboard controller. Each of these interfaces will be discussed in the later 
sections of this document. This section provides a quick reference to the pinouts of the various ports. 

2.3.1 Aux Power Connector Pinout 

The controller and auxiliary low-voltage hardware are powered from an external +12V supply. The power is 
applied through a CUI Devices® PJ-102AH barrel connector with the pinout shown in. The recommended mating 
connector is CUI Devices PP3-002A. 

1
2

 

Figure 4: J20 Input Power Connector Pin Numbers 

 

Table 3: J20 Input Power Connector Pinout 

Pin # Name Type Description 

1 +12V Power +12V Power 

2 GND Power Ground 
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2.3.2 High Power Terminals 

The high-power input DC bus and output phase connections are made through Würth Elektronik® 7460307 
terminals. These terminals include internal M4 threads to support mounting high-power wires or bus bars 
directly to the terminals with M4 screws. 

2.3.3 Voltage Feedback Connector Pinout 

The voltage feedback uses a Phoenix Contact® 1755778 connector with the pinout shown below. The 
recommended mating connector is either Phoenix Contact 1792799 or Phoenix Contact 1757051, depending on 
the desired orientation of the wires. Using Phoenix Contact 1792799 results in wires that are parallel with the 
circuit board and using Phoenix Contact 1757051 results in wires that are perpendicular to the circuit board.  

123456
 

Figure 5: J1 Voltage Feedback Connector Pin Numbers 

Table 4: J1 Voltage Feedback Connector Pinout 

Pin # Name Type Description 

1 U+ Analog (I) Positive Differential Phase U Voltage Feedback 

2 U- Analog (I) Negative Differential Phase U Voltage Feedback 

3 V+ Analog (I) Positive Differential Phase V Voltage Feedback 

4 V- Analog (I) Negative Differential Phase V Voltage Feedback 

5 W+ Analog (I) Positive Differential Phase W Voltage Feedback 

6 W- Analog (I) Negative Differential Phase W Voltage Feedback 

2.3.4 CAN Port Pinout 

The isolated CAN port is a standard male DB9 connector (Amphenol® L717SDE09PA4CH4RC309) with the pinout 
shown in below. This CAN port can be mated with any standard DB9 female connector.  
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1
6

5
9

 

Figure 6: J4 CAN Port Pin Numbers 

Table 5: J4 CAN Port Pinout 

Pin # Name Type Description 

1 NC0 — No Connect 

2 CAN_L Digital (I/O) Isolated CAN Low 

3 V- Power Isolated Ground 

4 NC1 — No Connect 

5 SHLD Power Isolated Ground 

6 O(V-) — No Connect 

7 CAN_H Digital (I/O) Isolated CAN High 

8 NC2 — No Connect 

9 V+ Power Isolated +5V Power 

2.3.5 Resolver Connector Pinout 

The design includes circuitry to attach a resolver for mechanical position feedback. The connector is Würth 
Elektronik 61200621621 with the pinout shown below. Although any 0.1 in (2.54 mm) female header connector 
can be used to attach the resolver, it is recommended to use a connector with a matching shroud to ensure 
proper orientation when attaching the resolver.  

1

2

5

6

 

Figure 7: J16 Resolver Connector Pin Numbers 
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Table 6: J16 Resolver Connector Pinout 

Pin # Name Type Description 

1 EXC_P Digital (O) Positive Differential Resolver Excitation Signal 

2 EXC_N Digital (O) Negative Differential Resolver Excitation Signal 

3 SIN_P Analog (I) Positive Differential Signal Resolver Sine Feedback 

4 SIN_N Analog (I) Negative Differential Signal Resolver Sine Feedback 

5 COS_P Analog (I) Positive Differential Signal Resolver Cosine Feedback 

6 COS_N Analog (I) Negative Differential Signal Resolver Cosine Feedback 

2.3.6 Relay Connector Pinout 

The design includes circuitry to drive external relays. The connectors for these relays are Phoenix Contact 
1755778 with the pinout shown below. The recommended mating connector is either Phoenix Contact 1792757 
or Phoenix Contact 1754449, depending on the desired orientation of the wires. Using Phoenix Contact 1792757 
results in wires that are parallel with the circuit board, and using Phoenix Contact 1754449 results in wires that 
are perpendicular to the circuit board. 

1 2 1 2
 

Figure 8: J11 and J15 Relay Connector Pin Numbers 

Table 7: J11 and J15 Relay Connector Pinout 

Pin # Name Type Description 

1 +12V Power +12V Power 

2 GND Power Controlled Ground 
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2.3.7 Spare Connector Pinout 

The design includes spare input/output pins which are connected directly to the controller following the pinout 
shown below. The connector part number is Würth Elektronik 61301221121. The headers use standard 0.1 in 
(2.54 mm) spacing between the pins, so any female header pins with this spacing can be used for mating.  

1 2

11 12
 

Figure 9: J8 Spare Connector Pin Numbers 

Table 8: J8 Spare Connector Pinout 

Pin # Name Type Description 

1 +3.3V Power +3.3V Power 

2 +5V Power +5V Power 

3 GND Power Ground 

4 GND Power Ground 

5 A14 Analog (I) Connected to Controller Analog A14 

6 C14 Analog (I) Connected to Controller Analog C14 

7 GPIO35 Digital (I/O) Connected to Controller GPIO35 

8 GPIO44 Digital (I/O) Connected to Controller GPIO44 

9 GPIO54 Digital (I/O) Connected to Controller GPIO54 

10 GPIO55 Digital (I/O) Connected to Controller GPIO55 

11 GND Power Ground 

12 +12V Power +12V Power 
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2.3.8 Metrology 

This design includes a variety of test points and probe connection points to measure various signals on the 
board in order to evaluate the design and test various control schemes.  

To measure the gate signals, each of the six MOSFETs are connected to a dedicated MMCX connector, which are 
connected across the MOSFET gate and source terminals. These measurements use Molex® 0734151471 
connectors and are in the locations shown below. These are standard MMCX connectors intended to be 
monitored directly with an oscilloscope probe. Notably, during system operation, the gate measurements can 
float at the full bus voltage. Therefore, the gate measurements should not be monitored using single-ended 
oscilloscope probes due to the safety risks of high-voltage potentials being applied to the oscilloscope 
reference. It is recommended to perform these gate measurements with high-isolation probes such as the 
Tektronix® IsoVuTM series of probes. 

The design also includes several through-hole test points to measure the high-power connections and the low-
power voltage rails. These test points are in the physical locations indicated in the figure below and are 
connected to the signals described in Table 9. The test points can be used to perform a variety of measurements 
such as measuring the output phase voltages, the DC-bus voltage, and/or the auxiliary power rails.  

Table 9: Test Point Descriptions 

Ref Designator Signal Color Description 

TP1 DC+ Red Positive DC-Link Voltage 

TP2 DC+ Red Positive DC-Link Voltage 

TP3 DC- Black Negative DC-Link Voltage 

TP4 DC- Black Negative DC-Link Voltage 

TP5 +3.3V Red +3.3V Power 

TP6 +5V Red +5V Power 

TP7 GND Black Ground 

TP8 +15V Red +15V Power 

TP9 -15V Red -15V Power 

TP10 U_OUT White U Phase 

TP11 V_OUT White V Phase 

TP12 W_OUT White W Phase 

TP13 GND Black Ground 

TP14 +12V Red +12V Power 

TP15 GND Black Ground 
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J14
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Figure 10: Gate and Test Point Measurement Locations 
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3. SYSTEM DESCRIPTION 

 

 

 

 

 

 

 

 

 

 

CAUTION 
 
IT IS NOT NECESSARY FOR YOU TO TOUCH THE BOARD WHILE IT IS ENERGIZED. WHEN DEVICES ARE BEING ATTACHED FOR 
TESTING, THE BOARD MUST BE DISCONNECTED FROM THE ELECTRICAL SOURCE AND ALL BULK CAPACITORS MUST BE FULLY 
DISCHARGED.  
 
SOME COMPONENTS ON THE BOARD REACH TEMPERATURES ABOVE 50⁰ CELSIUS. THESE CONDITIONS WILL CONTINUE 
AFTER THE ELECTRICAL SOURCE IS DISCONNECTED UNTIL THE BULK CAPACITORS ARE FULLY DISCHARGED. DO NOT TOUCH 
THE BOARD WHEN IT IS ENERGIZED AND ALLOW THE BULK CAPACITORS TO COMPLETELY DISCHARGE PRIOR TO HANDLING 
THE BOARD.  
 
PLEASE ENSURE THAT APPROPRIATE SAFETY PROCEDURES ARE FOLLOWED WHEN OPERATING THIS BOARD AS SERIOUS 
INJURY, INCLUDING DEATH BY ELECTROCUTION OR SERIOUS INJURY BY ELECTRICAL SHOCK OR ELECTRICAL BURNS, CAN 
OCCUR IF YOU DO NOT FOLLOW PROPER SAFETY PRECAUTIONS. 

警告 
 

通电时不必接触板子。连接器件进行测试时，必须切断板子电源，且大容量电容器必须释放完所有电荷。 
 
板子上一些组件的温度可能超过 50 摄氏度。移除电源后，上述情况可能会短暂持续，直至大容量电容器完全释放电荷。
通电时禁止触摸板子，应在大容量电容器完全释放电荷后，再操作电路板。 
 
请确保在操作电路板时已经遵守了正确的安全规程，否则可能会造成严重伤害，包括触电死亡、电击伤害、或电灼伤。，
大容量电容器已释放了所有电量。只有在切断板子电源，且大容量电容器完全放电后，才可更换待测试器件。 

警告 
 

通電している時にボードに接触する必要がありません。設備をつないで試験する時、必ずボードの電源を切ってくださ
い。また、大容量のコンデンサーで電力を完全に釈放してください。 
 
ボードのモジュールの温度は 50度以上になるかもしれません。電源を切った後、上記の状況がしばらく持続する可能性
がありますので、大容量のコンデンサーで電力を完全に釈放するまで待ってください。通電している時にボードに接触
するのは禁止です。大容量のコンデンサーで電力をまだ完全に釈放していない時、ボードを操作しないでください。 
 
ボードを操作している時、正確な安全ルールを守っているのを確保してください。さもなければ、感電、電撃、厳しい
火傷などの死傷が出る可能性があります。 
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3.1 Power Stage 

The power stage of this design uses three 65 μF low-inductance capacitors in parallel to form a total of 195 μF 
of DC-link capacitance. The capacitors used are KEMET® C4AQQEW5650A3BJ film capacitors with a voltage 
rating of 1.1 kV. They are charged through the input DC terminals and connect directly to the DC+ and DC- 
terminals of the power module using low-inductance copper pours. The DC-link capacitor circuitry and the 
connections to the power module are shown in the figures below. The printed circuit board used in this design 
features interleaved DC+ and DC- copper layers to increase the flux cancellation between layers and reduce the 
inductance between the capacitors and the power module input pins. The interleaved layers are indicated in 
the stack-up shown in Table 10, which shows the signals/planes on each circuit board layer in the area around 
the DC bus.  

 

Figure 11: DC Bus Circuitry 

Table 10: DC Bus Printed Circuit Board Layer Stack-up 

Layer # Primary Signals 

1 Gate 

2 Source 

3 DC- 

4 DC+ 

5 DC- 

6 DC+ 

 



 

              19 
PRD-07560 REV. 1, Sept 2023 CRD25DA12N-FMC 25 kW Three-Phase Inverter User Guide 
© 2023 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed 
logo is a trademark of Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective 
owners and do not imply specific product and/or vendor endorsement, sponsorship, or association. 

 

Figure 12: Wolfspeed CCB021M12FM3T Power Module Circuit Connections 

To ensure that the system is stored at a safe touch potential, the design includes bleed resistors which discharge 
the bus to less than 50 V in under 3 minutes when input voltage is removed from the system. These resistors are 
connected to the DC bus at all times to ensure the bus is always depleted after system shut down. The circuit 
bleed resistors are shown below. 

 

Figure 13: Bleed Resistors Connected to DC Bus 



 

              20 
PRD-07560 REV. 1, Sept 2023 CRD25DA12N-FMC 25 kW Three-Phase Inverter User Guide 
© 2023 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed 
logo is a trademark of Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective 
owners and do not imply specific product and/or vendor endorsement, sponsorship, or association. 

The output of each phase is independently measured with a hall-effect current transducer between the power 
module and the output power terminals of the PCB, as shown below. These connections feature wide copper 
pours to minimize inductance and maximize ampacity. These measurements provide feedback to the controller 
for detecting overcurrent events and for close-loop system control. These sensors and the corresponding 
measurement circuitry are discussed in more detail in the Current Sensing section of this document.  

 

Figure 14: Output Hall-Effect Sensor Power Connections 
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3.2 Gate Drivers 

Each of the MOSFET switch positions is driven with a dedicated power supply and gate driver integrated circuit 
(IC), both of which have continuous isolation barriers of over 2 kV. The circuit for one switch position is shown 
in the figure below. To prevent undesired coupling, there is an isolation gap between the controller signals and 
the high-voltage MOSFET connections. No copper crosses this isolation barrier, and the only components which 
cross the barrier are the isolated power supplies and gate driver ICs. The power supplies generate the isolated 
+15 V and -3 V rails required to properly bias the MOSFET gates and enough power to drive the MOSFETs at high 
switching frequencies.  

 

Figure 15: Gate Driver Circuit for One MOSFET Switch Position 

For the gate driver IC, the design uses the Texas Instruments® UCC5350SBD isolated gate driver, which has a 
sink/source drive strength of ±5 A. The selected gate driver IC includes a split output capable of sinking/sourcing 
current through separate turn-on and turn-off gate resistor. The split output allows users to independently 
optimize the turn-on and turn-off switching losses and edge rates. In traditional single output circuits, the same 
gate resistor must be used for both transition states, which could result in increased switching losses. By 
default, this design employs a 0.91 Ω turn-on resistor and a 0 Ω turn-off resistor, though these values can easily 
be changed by a user to reach the desired performance targets. The gate driver circuit includes input signal 
interlocks which prevent the IC from turning on when the high-side and low-side switch positions are 
simultaneously commanded on. This feature enables users to confidently evaluate prototype control software 
without the risk of shoot-through due to command errors from the controller. The gate driver IC also includes 
other built-in functionalities such as undervoltage lockout, low propagation delay, and high common-mode 
transient immunity. Some of the general specifications of the gate driver used in this design are shown in Table 
11, and more details about the built-in features of the gate driver IC can be found in the Texas Instruments 
UCC5350SBD datasheet.  
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Table 11: Gate Driver Operating Parameters 

Symbol Parameter Min. Typ. Max. Unit 

PDRIVE Power Per Gate Driver1 — — 1.7 W 

IO Output Peak Current (TA = 25 °C) — — ±5 A 

VGATE,HIGH High Level Output Voltage — 15 — 
V 

VGATE,LOW Low Level Output Voltage — -3 — 

RG(EXT)-ON External Turn-On Resistance — 0.91 — 
Ω 

RG(EXT)-OFF External Turn-Off Resistance — 0 — 

1 The gate driver power supply can be populated with Murata Power Solutions Inc. MGJ2D121503SC or with RECOM 
R12P21503D. This rating is the worse-case value of the two options. 

3.3 Current Sensing 

Each phase output of this design is directly measured using LEM® LAH 50-P closed-loop hall-effect transducers 
capable of measuring up to 50 ARMS with a rated bandwidth of 200 kHz. These sensors can be employed for 
custom closed-loop control schemes and/or overcurrent protection. The LEM LAH 50-P transducer has an 
insulation voltage rating of 1000 V between the primary and secondary circuits, enabling this sensor to be 
employed without requiring additional isolation. These sensors output a proportional current rather than a 
proportional voltage since an output current signal has improved immunity against electrical noise. 
Additionally, compared to open-loop transducers, closed-loop transducers are favored due to their higher 
accuracy and lower temperature drift. The maximum output phase current of this design is 30 ARMS which is 
safely within the operating range of the selected sensors. In order to drive these hall-effect sensors, this design 
includes bipolar ±15 V power rails which power the sensors. The power connections for one of the hall-effect 
transducers are shown below.  

 

Figure 16: Hall-Effect Transducer Power Connections 
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The current signal output from the hall-effect transducers is converted to a voltage, filtered, and scaled before 
being sensed with dedicated analog-to-digital converter (ADC) inputs on the controller. The voltage 
conditioning for the current sensors is shown in the figures below.  

 

Figure 17: Current Measurement Conversion to Voltage and Filtering 

 

Figure 18: Current Measurement Conditioning 

In additional to the ADC measurements, the filtered current signals are also connected directly to comparators 
for detecting overcurrent events (both positive and negative magnitude currents). This circuitry enables users 
to shut the system down if the system enters an unsafe or undesired operating condition. Notably, the 
overcurrent detection could instead be employed using the controller ADC measurements. These hardware-
defined overcurrent circuits enable users to evaluate alternative approaches when computing power and/or 
available input pins are limited. An example of the overcurrent detection circuit for one phase is shown below. 
The overcurrent trip limits can be adjusted by varying the reference resistors, R66, R67, R71, and R73 shown in 
the reference voltage circuit below.  
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Figure 19: Overcurrent Detection Circuit 

 

Figure 20: Overcurrent Trip References 

3.4 Voltage Sensing 

The design includes the built-in hardware necessary to perform differential voltage measurements of the DC 
bus. These connections are included on the circuit by default, so users do not need to add any hardware 
connections for this functionality. In many configurations, this DC bus measurement can be paired with the 
phase current measurements to operate the design in closed-loop mode. The DC voltage conditioning circuit is 
shown below. 
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Figure 21: Differential DC Voltage Conditioning 

For control schemes where phase voltages are required, the design also includes the hardware necessary to 
perform differential voltage measurements of the output signals. These differential inputs can be placed close 
to the target load and can measure the output voltage as line-to-line or line-to-neutral. These measurements 
have multiple target use cases depending on the application. For example, these measurements can be used to 
directly monitor the voltages applied to the terminals of a motor. Alternatively, the feedback voltage signals 
could be used to measure input line voltages if this design is utilized as a building block for an active front end 
(AFE). These phase voltage measurements are not required in many control schemes but are included for users 
who want to evaluate control schemes which require them. The voltage conditioning circuit for one phase is 
shown below.  

 

Figure 22: Differential Phase Voltage Conditioning 
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3.5 NTC 

The CCB021M12FM3T power module used in this design includes a negative temperature coefficient (NTC) 
sensor for monitoring the substrate temperature inside the module. While this temperature is not the junction 
temperature of the MOSFETs, this measurement can be employed to estimate the device temperatures and 
detect problematic operating conditions. This design has provisions to directly measure the power module NTC. 
The circuit converts the voltage to a digital 50 kHz pulse-width modulated (PWM) signal with varying duty cycle. 
The PWM signal is processed through a digital isolator and the output signal can be directly measured by the 
controller. The duty cycle varies depending on the measured NTC temperature and follows 

𝑇𝑇𝑁𝑁𝑁𝑁𝑁𝑁 = −(4.26587 × 10−4)𝑑𝑑3 + 0.0607083𝑑𝑑2 − 4.24309𝑑𝑑 + 216.674 

where 𝑑𝑑 is the measured duty cycle [0-100] and 𝑇𝑇𝑁𝑁𝑁𝑁𝑁𝑁  is the calculated temperature [°C]. This relationship was 
fit to experimental data. The NTC circuit used in this design is shown below. 

 

Figure 23: NTC Measuring Circuit 

3.6 Position Sensing 

This design includes provisions for measuring the mechanical position of a motor or other rotating device 
through a resolver sensor. The resolver is a common position measuring technique due to its few electrical 
components which enables operation in high vibration environments. To operate a resolver, an excitation 
sinusoidal signal is sent to the resolver and the resolver sensor returns the cosine and sine signals related to the 
sensor position. For the excitation signal in this design, the controller generates a PWM signal which is 
converted with on-board hardware to a sinewave and amplified. These excitation circuits are shown below.  
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Figure 24: Resolver PWM to Sinewave 

 
Figure 25: Resolver Excitation Amplifier 
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The sine and cosine differential feedback signals from the resolver are conditioned through an operational 
amplifier circuit to filter them and to center the signals at 1.5V rather than 0V. With this adjustment, the signals 
can be measured directly with the ADCs of the +3.3V controller. The conditioning circuit for the sine feedback is 
shown in below. 

 

Figure 26: Resovler Sine Signal Conditioning 

3.7 Additional Circuitry 

The circuit includes several provisions for customization by a user to fit specific application needs. Along with 
the ability for swapping the controller and loading firmware off the board, this circuit includes hardware 
connections for attaching additional sensors and equipment based on customization needs. First, this circuit 
includes three LEDs with no predefined functionality. The three LEDs vary in color (green, yellow, red) allowing 
users to add custom warnings or feedback during system initialization and testing. These LEDs are shown below. 

 

Figure 27: Customizable LEDs 
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Second, this design includes exposed header pins which connect to multiple analog-to-digital converter (ADC) 
pins and general-purpose input/output (GPIO) pins of the controller. Similar to the LEDs, these pins do not serve 
an inherent function and instead serve to provide users with easy access to controller pins and therefore to 
customization opportunities. By default, each signal is connected to a 0 Ω resistor and a not populated filter 
capacitor. Depending on the application, various resistor and capacitor sizes can be soldered to introduce a 
hardware-level filter. The spare connector headers also include a direct link to the three power rails on the 
circuit board (+3.3V, +5V, and +12V) and multiple ground connections so users can power a variety of external 
circuits or sensors. The circuit for these connections is shown below. 

 

Figure 28: Spare ADCs, GPIOs, and Power Rail Connections 

Third, the circuit board supports operating two external +12V relays for applications such as incorporating the 
circuit into an overall larger fault detection setup. For example, the circuit can drive relays can be used in series 
with a fault circuit or emergency shutdown equipment so a fault can be triggered in a higher-level system. 
Alternatively, the circuit can drive relays to operate higher-power equipment such as charge/discharge relays 
or in-rush current limiting equipment. Although the circuit was intended to drive relays, these connections can 
be used to drive any higher current equipment. Each relay connection is attached to a freewheeling diode and 
a low-side controlled transistor capable of operating up to 8A. However, this current is primarily limited by the 
input +12V power connector which is pin limited to 5A for the entire +12V rail, assuming that a suitable input 
power supply is used to power the circuit. If high currents are required for the external relay circuit, it is 
recommended to power those with another power source (other than this circuit board) and simply use these 
outputs to control the circuit. These relay driving circuits are designed to be general in nature and thus their 
purpose can be customized based on specific application needs. The relay driving circuit is shown below. 
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Figure 29: Relay Driving Circuit 

4. CONTROLLER AND FIRMWARE 

4.1 Microcontroller 

The controller stage of the CRD25DA12N-FMC inverter system was designed around the F280039C 
controlCARD™ (TMDSCNCD280039C) from Texas Instruments (TI) C2000™ family of real-time microcontrollers. 
The controlCARD plugs directly into the inverter board via a Samtec® HSEC8-160-01-L-DV-A-BL high-speed edge 
connector (U5) as shown below. The on-board isolated XDS110 USB-to-JTAG debug probe is a convenient 
interface to run and debug firmware without additional hardware by connecting a USB-C cable between J1:A 
and a host computer. More information about running firmware is provided in the next section. 

While the CRD25DA12N-FMC inverter was exclusively tested with the F280039C controlCARD, theoretically, any 
microcontroller daughter card with an equivalent pinout could be used. To this end, and to aid with user code 
development, the complete pinout of U5 along with signal descriptions of utilized pins is provided below. 

https://www.ti.com/tool/TMDSCNCD280039C
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Figure 30: F280039C controlCARD plugged into U5 
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2
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Figure 31: U5 Controller Connector Pin Numbers 
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Table 12: U5 Controller Connector Pinout 

# Name Type Description  Description Type Name # 

1 NC — No Connect  No Connect — NC 2 

3 NC — No Connect  No Connect — NC 4 

5 NC — No Connect  No Connect — NC 6 

7 GND_0 Power Ground  No Connect — NC 8 

9 VU_MEAS Analog (I) U Differential 
Voltage Meas. 

 Ground Power GND_1 10 

11 VV_MEAS Analog (I) 
V Differential 
Voltage Meas.  No Connect — NC 12 

13 GND_2 Power Ground  No Connect — NC 14 

15 NC — No Connect  Ground Power GND_3 16 

17 VW_MEAS Analog (I) W Differential 
Voltage Meas. 

 No Connect — NC 18 

19 GND_4 Power Ground  No Connect — NC 20 

21 VDC_MEAS Analog (I) DC Differential 
Voltage Meas.  Ground Power GND_5 22 

23 NC — No Connect  No Connect — NC 24 

25 NC — No Connect  No Connect — NC 26 

27 NC — No Connect  No Connect — NC 28 

29 GND_6 Power Ground  Resolver Sine 
Feedback 

Analog (I) SIN 30 

31 NC — No Connect  No Connect — NC 32 

33 IU_MEAS Analog (1) U Current Meas.  Resolver Cosine 
Feedback Analog (I) COS 34 

35 GND_7 Power Ground  
Spare 

Controller 
Analog Input 

Analog (I) A14 36 

37 IV_MEAS Analog (I) V Current Meas.  Ground Power GND_8 38 

39 IW_MEAS Analog (I) W Current Meas.  
Spare 

Controller 
Analog Input 

Analog (I) C40 40 

41 NC — No Connect  No Connect — NC 42 

43 NC — No Connect  No Connect — NC 44 

45 NC — No Connect  Ground Power GND_9 46 

47 GND_10 Power Ground  +5V Power Power 5V_0 48 
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# Name Type Description  Description Type Name # 

49 U_HS_PWM Digital (O) 
High-Side Phase 
U PWM Control  

High-Side Phase 
W PWM Control Digital (O) W_HS_PWM 50 

51 U_LS_PWM Digital (O) High-Side Phase 
U PWM Control  Low-Side Phase 

W PWM Control Digital (O) W_LS_PWM 52 

53 V_HS_PWM Digital (O) High-Side Phase 
V PWM Control  No Connect — NC 54 

55 V_LS_PWM Digital (O) Low-Side Phase 
V PWM Control  No Connect — NC 56 

         

57 NTC_ISO Digital (I) Temperature 
PWM Meas.  No Connect — NC 58 

59 NC — No Connect  No Connect — NC 60 

61 NC — No Connect  No Connect — NC 62 

63 NC — No Connect  
Resolver 

Excitation PWM Digital (O) RSLV_PWM 64 

65 GND_11 Power Ground  No Connect — NC 66 

67 NC — No Connect  No Connect — NC 68 

69 NC — No Connect  No Connect — NC 70 

71 NC — No Connect  No Connect — NC 72 

73 NC — No Connect  Gate Driver  
Disable 

Digital (O) GD_DIS 74 

75 NC — No Connect  No Connect — NC 76 

77 NC — No Connect  No Connect — NC 78 

79 U_HI_OC Digital (I) Phase U High 
Overcurrent  No Connect — NC 80 

81 U_LO_OC Digital (I) Phase U Low 
Overcurrent 

 No Connect — NC 82 

83 GND_12 Power Ground  +5V Power Power 5V_1 84 

85 NC — No Connect  No Connect — NC 86 

87 CAN_RX Digital 
(I/O) 

Non-isolated 
CAN RX 

 Non-Isolated 
CAN TX 

Digital 
(I/O) 

CAN_TX 88 

89 NC — No Connect  
Spare 

Controller GPIO 
Digital 

(I/O) GPIO35 90 

91 V_HI_OC Digital (I) Phase V High 
Overcurrent 

 Spare 
Controller GPIO 

Digital 
(I/O) 

GPIO44 92 

93 V_LO_OC Digital (I) Phase V Low 
Overcurrent 

 Red LED Control Digital (O) LED_R 94 
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# Name Type Description  Description Type Name # 

95 LED_Y Digital (O) Yellow LED 
Control 

 Green LED 
Control 

Digital (O) LED_G 96 

97 GND_13 Power Ground  +5V Power Power 5V_2 98 

99 W_HI_OC Digital (I) Phase W High 
Overcurrent 

 Spare Controller 
GPIO 

Digital 
(I/O) 

GPIO54 100 

101 W_LO_OC Digital (I) Phase W Low 
Overcurrent 

 Spare Controller 
GPIO 

Digital 
(I/O) 

GPIO55 102 

103 NC — No Connect  No Connect — NC 104 

105 NC — No Connect  Relay Control Digital (O) RELAY1_OUT 106 

107 NC — No Connect  Relay Control Digital (O) RELAY2_OUT 108 

109 NC — No Connect  No Connect — NC 110 

111 GND_111 Power Ground  +5V Power Power 5V_3 112 

113 NC — No Connect  No Connect — NC 114 

115 NC — No Connect  No Connect — NC 116 

117 NC — No Connect  No Connect — NC 118 

119 NC — No Connect  +5V Power 
(Disabled) 

Digital (I) ~RST 120 

4.2 Firmware 

Wolfspeed provides firmware that consists of basic open-loop three-phase sine-PWM control of the inverter 
along with a graphical user interface (GUI) that manipulates the parameters of the open-loop control from a 
host computer via the CAN communication protocol. Altogether, this control suite allows the user to test the 
reference design at the desired test conditions without the need to modify the controller firmware. 
Alternatively, the provided firmware source code can be modified at the user’s discretion or used as a starting 
point for users to develop and implement their own application-specific control law. The firmware and GUI for 
the CRD25DA12N-FMC reference design can be requested separately from Wolfspeed’s website on the 
CRD25DA12N-FMC landing page. 

4.2.1 Code Composer Studio Project 

The CRD25DA12N-FMC firmware is provided as a Code Composer Studio™ (CCS) project. The project was 
developed and tested with CCS version 12.3.0, so this version or newer is recommended to build and run this 
project. If not installed, download and install CCS from TI’s website. The CCS User’s Guide provides more details 
about CCS installation and use. 

 

https://www.wolfspeed.com/products/power/reference-designs/crd25da12n-fmc/
https://www.ti.com/tool/CCSTUDIO
https://software-dl.ti.com/ccs/esd/documents/users_guide/index.html
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The software project was also developed and built with TI’s C2000Ware to provide device-specific drivers and 
libraries. C2000Ware version 4.03.00.00 was used for development and testing, so this version or newer is 
recommended. C2000Ware is a separate installation from CCS, so if not installed, download and install 
C2000Ware from TI’s website. 

Once the required software is installed, the following instructions can be used to import and run the provided 
CRD25DA12N-FMC Firmware CCS project. To import the project into CCS, click Project → Import CCS Projects 
and browse to the local directory where the downloaded project was saved <Local Directory>\CRD25DA12N-FMC 
Firmware and click Select Folder. Verify the CRD25DA12N-FMC Firmware project was discovered and click 
Finish. Once properly imported, the project should look like the figure below.  

 

Figure 32: CRD25DA12N-FMC Firmware CCS Project Explorer View  

The default build configuration is 28003x_RELEASE with the linker command file 28003x_generic_flash_lnk.cmd 
specified to run the program from Flash memory and the TMS320F280039C.ccxml target configuration file to use 
the on-board XDS110 USB Debug Probe on the F280039C controlCARD. The Board_source folder contains all of 
the hardware-specific source files to run the design. This includes the drivers for current, voltage, and 
temperature sensing, along with the CAN communication protocol. An empty c2000.syscfg file is provided if it is 
desired to use the SysConfig functionality for further code development and generation, although the project 
was not originally developed with the SysConfig tool. 

https://www.ti.com/tool/C2000WARE
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To build the project, click Project → Build Project or click on the Build icon button on the toolbar. Monitor the 
Console pane to confirm the project was successfully built without any errors. Address any errors listed in the 
Problems pane, if they occur. If there are no errors, go to Run → Debug or click on the Debug icon to launch a 
debug session. Once the debug session is launched, the program will be halted at the start of main(). Go to Run 
→ Resume or click the Resume icon to start running the code. Add desired variables to the Expressions pane 
and click the Continuous Refresh icon to continuously monitor them during the debug session. 

4.2.2 CAN Communication GUI 

In addition to the open-loop three-phase sine-PWM control law being executed by the code, a CAN 
communication protocol is also operating in the background to provide the ability to manipulate the 
parameters of the open-loop control from a host computer using the Wolfspeed provided GUI. Once 
downloaded and extracted, run the FMC Inverter CAN Interface.exe file where the Communication Setup dialog 
shown below will appear.  

 

Figure 33: Communication Setup Dialog Box 

Click on the drop-down menu to select the proper Interface and input the correct settings for Channel and Bit 
Rate as determined by the CAN hardware adapter being used. The GUI was built using the python-can library 
which provides support for various hardware adapters. Please refer to the python-can library documentation 
to find a list of the available CAN Interface Modules and how each setting should be configured. Once 
communication is established by clicking Connect!, the FMC Inverter CAN Interface GUI control window will pop 
up and will look like what is shown below. A command window will also show a log of the raw CAN packets that 
are sent and received on the CAN bus. If there is an invalid packet, a warning will be printed, and the errors will 
be displayed in this window. By default, the CAN packets are transmitted and encoded/decoded in code 
approximately once every second. 

https://python-can.readthedocs.io/en/master/interfaces.html
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Figure 34: FMC Inverter CAN Interface GUI 

The GUI control panel provides Inputs fields that consist of four numerical inputs and one toggle-button. 
Pressing the Send Packet button sends a new CAN packet with the populated values of each input field. A 
description of each Inputs field is given below. 

Switching Frequency field is the frequency of the output PWM in kHz. The default value is 20 = 20 kHz. The 
input range is 1 – 100. 

Modulation Factor field is the modulation factor (depth) of the reference sinusoidal wave for the output PWM, 
scaled by a factor of 1000. The default value is 10 = 0.01 MF. The input range is 0 – 1000.  

Dead time field is the dead-time between the complementary high-side and low-side switch position PWM for 
each bridge-leg in nanoseconds (ns). The default value is 300 = 300 ns dead-time. The input range is 100 – 2000.  

Fundamental Frequency field is the fundamental frequency of the reference sinusoidal wave in Hz. The default 
value is 300 = 300 Hz.  The input range is 1 – 500. 

Logic Enable toggle-button enables and disables the PWM logic of all six switch positions. By default, the logic 
is disabled, so the toggle-button is highlighted red (DIS). When enabled, the toggle-button will turn green (EN).  

The Response field displays the values contained in the most recent packet sent from the controller, indicating 
the status of each control parameter or confirming values were properly updated after a new input packet was 
sent. Also included in the information sent by the controller in each packet are the feedback values for the 
measured Bus Voltage (V) and NTC Temperature (°C). Pressing the Quit button will close the GUI.  
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5. PERFORMANCE DATA 

5.1 Heatsink 

The thermal performance of the module and system is influenced by its ability to reject heat from the device 
junction to its ambient environment. The baseplate-less design of the Wolfspeed CCB021M12FM3T already 
reduces the device thermal impedance compared to a similarly sized power modules since less material (i.e. 
baseplate) is present in the thermal path. To further maintain thermal integrity, this design uses the Fischer 
Elektronik® LA6 heatsink with a 33 CFM integrated axial fan to cool the power module.  

The junction-to-heatsink thermal impedance Zth for the power module is provided in the device datasheet. 
However, to evaluate the thermal performance of this reference design, the thermal impedance of the heatsink 
was also characterized. Characterizing the heatsink within the system was performed using a Siemens® 
Simcenter POWERT3ster™, which is an all-in-one thermal evaluation instrument to determine the thermal 
impedance of devices and applications. The single pulse transient thermal impedance measurements of the 
module, heatsink, and their combination is shown below. Note that these measurements are for a single switch 
position of the power module. 

 
Figure 35: Transient Thermal Impedance Measurements 
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The resulting junction-to-ambient thermal resistance Rth for the entire system is 1.571 °C/W. From the device 
datasheet, the module junction-to-heatsink Rth is 1.032 °C/W. Note that this value already includes the pre-
applied TIM layer. Therefore, the contribution of the heatsink to the overall Rth is approximately 0.539 °C/W. The 
extracted 4th order Cauer network of the heatsink performance is shown below. This thermal network can be 
used in tandem with the PLECS® model of the Wolfspeed CCB021M12FM3T to simulate this reference design. 
This is discussed in more detail in the “Simulation” section of this document.   

 

Figure 36: Heatsink 4th Order Cauer Network 

5.2 Inductance 

The layout of the printed circuit board was designed with multiple interleaved copper layers in order to 
minimize the board inductance. To validate the low-inductance design, the commutation inductance of the 
board (from DC+ to DC-) was measured with a Keysight® 42941A impedance probe attached to a Keysight 
E4990A impedance analyzer. The resulting inductance measurement is shown in Figure 37. Due to the 
interleaved copper layers, the board demonstrates only 8.6 nH of inductance at 10 MHz.  

 

 

Figure 37: Measured circuit board commutation inductance 
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5.3 Experimental Validation 

5.3.1 Setup 

The system was loaded with one Würth Elektronik 760801301 inductor per phase in a wye connected 
configuration. The Würth Elektronik 760801301 inductors have a rated inductance of 180 μH and dc resistance 
of 20 mΩ. The design was power with a Magna Power TSD1000-30/208+LXI power supply unit (PSU) with a rated 
output of up to 1000 V and 30 kW. The experimental setup is shown below. The output currents, phase voltages, 
and gate voltages were measured using a Tektronix MSO58B oscilloscope with a rated bandwidth of 1 GHz. 
These measurements were performed with isolated high-bandwidth probes which are summarized below.  

 

Figure 38: Experimental Setup 

Table 13: Experimental Setup Oscilloscope Probes 

Measurement Probe Description 

IU, IV, IW PEM® CWT UM/3/B/1/160 600 A, 30 MHz, Rogowski Coil 

VU, VV, VW Tektronix THDP0200 1.5 kV, 200 MHz, Differential Probe 

VGS,U,LS, VGS,U,HS Tektronix IsoVuTM TIVH05 50X Tip, 500 MHz, Optically Isolated Probe 
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5.3.2 Experimental Results 

The system was evaluated at several operating conditions to validate the system performance. Parameters 
such as the switching frequency (fsw), deadtime (tdead), and modulation index (mf) were evaluated at a range of 
values. An example waveform is shown below in Figure 39, demonstrating the system operation over the 
duration of several fundamental periods at the full load current of 30 Arms (mf = 41). Here the inverter is operating 
at a bus voltage of 800 V, a switching frequency of 20 kHz, with 300 ns of deadtime.  

Additional measurements were performed for shorter time durations to validate other system performance 
parameters. An example short duration measurement is shown below in Figure 40 for the same operating 
conditions as previously described. Inspection of the oscilloscope screenshot shows the system is operating 
with sufficient deadtime since the switch transitions are completed before the complementary switches begin 
to turn on. Similarly, the phase voltages have minimal overshoot and ringing as indicated by the maximum 
phase voltage of 1.021 kV on an 800 V DC bus and the short duration for the transient ringing to end. Minimal 
overshoot and ringing are also observed in the gate voltage measurements.  

To validate the long-term performance of the evaluation board, the inverter was operated for over an hour 
under the same test conditions: Iload = 30 Arms, Vbus = 800 V, fsw = 20 kHz, tdead = 300 ns, and Tambient = 21 °C. The 
thermal image in Figure 41 was taken at the end of the allotted time, demonstrating adequate thermal 
performance of the power PCB. The temperature scale is in degree Celsius. At that time, the NTC temperature 
was reading 38 °C. 

 

Figure 39: Experimental Measurements at Vbus = 800 V, fsw = 20 kHz, tdead = 300 ns, and 30 Arms (mf = 41) 
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Figure 40: System Switching Performance at Vbus = 800 V, fsw = 20 kHz, tdead = 300 ns, and 30 Arms (mf = 41) 

 

Figure 41: Thermal Image of CRD25DA12N-FMC PCB after one hour. 
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5.3.3 Thermal Safe Operating Area 

As described in the datasheet for the Wolfspeed CCB021M12FM3T, the package is limited to 30 Arms by the pins 
of the module. At high switching frequency, the module is further limited by the junction temperature of the die 
due to the higher switching losses at elevated switching frequencies. Using the default gate resistors on the 
CRD25DA12N-FMC (RG(EXT)-ON = 0.91 Ω and RG(EXT)-OFF = 0 Ω), the system is able to operate at rated pin current up to 
100 kHz for a bus voltage of 800 V and an ambient temperature of 25 °C. Current derating is required to achieve 
higher switching frequencies. This safe operating area shown below was generated from a combination of 
simulated and experimental results. 

 

Figure 42: Thermal Safe Operating Area for Tambient = 25 °C 
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5.4 Simulation 

A PLECS® simulation of the hardware is included as a download with the design files. The simulation is shown 
below, and the various subsystems are explained in the following sections. The simulation can be employed by 
interested users as a replacement for purchasing the hardware, as a tool to evaluate whether to purchase the 
hardware, and/or as a tool for making custom modifications to the controller. This simulation requires an active 
license of PLECS in order to run the simulation (PLECS Standalone 4.6.0 or newer is recommend). Licenses for 
PLECS can be purchased at https://www.plexim.com/products/plecs. More information about how to use 
PLECS can be found in the help guides on the PLECS website and in the program documentation. For users not 
familiar with PLECS, tutorials covering basic usage of the software are available at 
https://www.plexim.com/support/tutorials.  

 

Figure 43: CRD25DA12N-FMC Simulation 

 

 

 

 

 

https://www.plexim.com/products/plecs
https://www.plexim.com/support/tutorials
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As with the actual hardware, the power stage of the inverter uses the Wolfspeed CCB021M12FM3T six-pack 
baseplate-less module. The top-level of the simulation is shown below. To run the model, users need to direct 
PLECS to the thermal model for the MOSFET and body diode which can be downloaded from 
https://www.wolfspeed.com/tools-and-support/power/ltspice-and-plecs-models/. To add the device models 
to the simulation: 

1) Download “All SiC Module PLECS Models” from the page linked above and unzip the models into a 
suitable directory 

2) In PLECS, navigate to “File” → “Preferences” → “Thermal”. 
3) Select “+” (Add) and navigate to the unzipped PLECS model folder. Select “Apply” to apply the changes. 
4) Select the "Rescan" button and then "OK". 
5) The simulation is now ready. Start the simulation by navigating to “Simulation” → “Start” 

5.4.1 Power Stage 

The power stage subsystem includes the power module MOSFET models and the corresponding thermal 
networks to the ambient temperature. As described in the “Heatsink” section of this document, the thermal 
impedance of the heatsink in this system was directly measured and a 4th order Cauer network was fit to the 
data. When paired with the PLECS model of the Wolfspeed CCB021M12FM3T, this produces an accurate thermal 
model of the entire system. This pairing is shown in the simulation power stage subsystem shown below.  

 

Figure 44: Power Stage Subsystem 

https://www.wolfspeed.com/tools-and-support/power/ltspice-and-plecs-models/
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5.4.2 Controller 

The simulation parameters are configured to match the experimental testbed used to validate the hardware 
discussed in the “Experimental Validation” section of this document. To match that configuration, the 
simulation uses sine-PWM (SPWM) modulation for generating the gate signals and is operated in an open-loop 
configuration. The SPWM modulation controller used to generate the gate signals is shown below.  

 

Figure 45: Gate Signals Subsystem 

5.4.3 Load 

The load in the simulation uses the parameters of one Würth Elektronik 760801301 inductor per phase in a wye 
connection. This matches the experimental setup discussed earlier in this document. The simulation is a series 
RL load using the nominal inductance (180 μH) and dc resistance (20 mΩ) values from the inductor datasheet. 
The load subsystem is shown below 

 

Figure 46: Load Subsystem  
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5.4.4 Performance Monitor 

The simulation includes a subsystem to monitor the primary performance characteristics of the model (output 
currents, switching losses, conduction losses, and junction temperature). This subsystem is shown below.  

 

Figure 47: Simulation Performance Subsystem 
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5.4.5 Default Parameters 

The simulation values are populated using the initialization script found by navigating to “Simulation”  
“Simulation parameters…” → “Initialization”. The default parameters which have been tested are shown below. 
As mentioned previously, these default parameters align with the experimental testbed used to evaluate the 
hardware. For testing other configurations, such as changing the line frequency, users may have to adjust load 
parameters to properly evaluate the system at those operating conditions. 

 

Figure 48: Default Simulation Parameters 
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5.4.6 Validation 

The performance of the simulation can be easily evaluated using the “Compare to Experimental Data” section 
of the simulation. One configuration of this subsystem is shown below. This subsystem imports experimentally 
measured output currents from a stored CSV file and compares the simulated output currents to this imported 
data. The imported data is from the same setup as described in the “Experiment Validation” section of this 
document. Note that the data is down sampled from the original sampling rate to reduce the CSV file size.  

 

 

Figure 49: Compare Experimental Data Subsystem 

 

By clicking on the configurable subsystem, users can select experimental data to compare against the 
simulation results. Each file is saved by the name “XXkHz, YYmf, ZZA” where XX is the experimental data 
switching frequency (kHz), YY is the modulation factor (unitless, 0-1000), and ZZ is the output current (Arms). For 
these comparisons to be viewed properly, users need to ensure that the switching frequency (fsw) and 
modulation factor (mf) in the initialization script match the selected configuration settings and all other 
settings are set to the default values. An example comparison for fsw = 20 kHz, mf = 41 is shown below. The green 
waveforms are the simulated values and the red waveforms are the experimental values.  
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Figure 50: Example Simulation Validation 
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5.4.7 Efficiency Predictions 

Using the simulation and the empirically measured thermal network, the system efficiency can be predicted. 
The results of this analysis are shown in Figure 51. At full load, the system is over 98% efficient across the 
complete range of rated switching frequencies. Additionally, at the default system switching frequency of 
20 kHz, the system operates above 99% efficiency from 5 kW to 25 kW, peaking at 99.5% efficiency.  

 

Figure 51: Predicted System Efficiency Based on Simulation for Tambient = 25 °C 
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6. MECHANICAL ASSEMBLY 
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REVISION HISTORY 

Date Revision Changes 

May 2023 Rev. 0 Initial Release 

Sept 2023 Rev. 1 

Formatted to match updated Wolfspeed template 
Updated Controller section to include firmware and GUI, now called 
Controller and Firmware 
Added Performance Data section covering heatsink, inductance, 
experimental validation, thermal SOA and simulation details 
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IMPORTANT NOTES 

PURPOSES AND USE 
Wolfspeed, Inc. (on behalf of itself and its affiliates, “Wolfspeed”) reserves the right in its sole discretion to make 
corrections, enhancements, improvements, or other changes to the board or to discontinue the board.  

THE BOARD DESCRIBED IS AN ENGINEERING TOOL INTENDED SOLELY FOR LABORATORY USE BY HIGHLY 
QUALIFIED AND EXPERIENCED ELECTRICAL ENGINEERS TO EVALUATE THE PERFORMANCE OF WOLFSPEED 
POWER SWITCHING DEVICES.  THE BOARD SHOULD NOT BE USED AS ALL OR PART OF A FINISHED PRODUCT.  
THIS BOARD IS NOT SUITABLE FOR SALE TO OR USE BY CONSUMERS AND CAN BE HIGHLY DANGEROUS IF NOT 
USED PROPERLY. THIS BOARD IS NOT DESIGNED OR INTENDED TO BE INCORPORATED INTO ANY OTHER 
PRODUCT FOR RESALE. THE USER SHOULD CAREFULLY REVIEW THE DOCUMENT TO WHICH THESE 
NOTIFICATIONS ARE ATTACHED AND OTHER WRITTEN USER DOCUMENTATION THAT MAY BE PROVIDED BY 
WOLFSPEED (TOGETHER, THE “DOCUMENTATION”) PRIOR TO USE.  USE OF THIS BOARD IS AT THE USER’S SOLE 
RISK.  

OPERATION OF BOARD 
It is important to operate the board within Wolfspeed’s recommended specifications and environmental 
considerations as described in the Documentation. Exceeding specified ratings (such as input and output 
voltage, current, power, or environmental ranges) may cause property damage. If you have questions about 
these ratings, please contact Wolfspeed prior to connecting interface electronics (including input power and 
intended loads). Any loads applied outside of a specified output range may result in adverse consequences, 
including unintended or inaccurate evaluations or possible permanent damage to the board or its interfaced 
electronics. Please consult the Documentation prior to connecting any load to the board. If you have any 
questions about load specifications for the board, please contact Wolfspeed at forum.wolfspeed.com for 
assistance.   

Users should ensure that appropriate safety procedures are followed when working with the board as serious 
injury, including death by electrocution or serious injury by electrical shock or electrical burns can occur if you 
do not follow proper safety precautions.  It is not necessary in proper operation for the user to touch the board 
while it is energized. When devices are being attached to the board for testing, the board must be disconnected 
from the electrical source and any bulk capacitors must be fully discharged. When the board is connected to an 
electrical source and for a short time thereafter until board components are fully discharged, some board 
components will be electrically charged and/or have temperatures greater than 50˚ Celsius. These components 
may include bulk capacitors, connectors, linear regulators, switching transistors, heatsinks, resistors and SiC 
diodes that can be identified using board schematic.  Users should contact Wolfspeed for assistance if a board 
schematic is not included in the Documentation or if users have questions about a board’s components. When 
operating the board, users should be aware that these components will be hot and could electrocute or 
electrically shock the user. As with all electronic evaluation tools, only qualified personnel knowledgeable in 
handling electronic performance evaluation, measurement, and diagnostic tools should use the board. 

USER RESPONSIBILITY FOR SAFE HANDLING AND COMPLIANCE WITH LAWS 
Users should read the Documentation and, specifically, the various hazard descriptions and warnings 
contained in the Documentation, prior to handling the board. The Documentation contains important safety 
information about voltages and temperatures.   
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Users assume all responsibility and liability for the proper and safe handling of the board. Users are responsible 
for complying with all safety laws, rules, and regulations related to the use of the board. Users are responsible 
for (1) establishing protections and safeguards to ensure that a user’s use of the board will not result in any 
property damage, injury, or death, even if the board should fail to perform as described, intended, or expected, 
and (2) ensuring the safety of any activities to be conducted by the user or the user’s employees, affiliates, 
contractors, representatives, agents, or designees in the use of the board. User questions regarding the safe 
usage of the board should be directed to Wolfspeed at forum.wolfspeed.com. 

In addition, users are responsible for:  

● compliance with all international, national, state, and local laws, rules, and regulations that apply to the 
handling or use of the board by a user or the user’s employees, affiliates, contractors, representatives, agents, 
or designees.  

● taking necessary measures, at the user’s expense, to correct radio interference if operation of the board 
causes interference with radio communications.  The board may generate, use, and/or radiate radio frequency 
energy, but it has not been tested for compliance within the limits of computing devices pursuant to Federal 
Communications Commission or Industry Canada rules, which are designed to provide protection against radio 
frequency interference.   

● compliance with applicable regulatory or safety compliance or certification standards that may normally be 
associated with other products, such as those established by EU Directive 2011/65/EU of the European 
Parliament and of the Council on 8 June 2011 about the Restriction of Use of Hazardous Substances (or the 
RoHS 2 Directive) and EU Directive 2002/96/EC on Waste Electrical and Electronic Equipment (or WEEE).  The 
board is not a finished end product and therefore may not meet such standards.  Users are also responsible for 
properly disposing of a board’s components and materials.   

NO WARRANTY 
THE BOARD IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO ANY 
WARRANTY OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE, WHETHER 
EXPRESS OR IMPLIED. THERE IS NO REPRESENTATION THAT OPERATION OF THIS BOARD WILL BE 
UNINTERRUPTED OR ERROR FREE.   

LIMITATION OF LIABILITY 
IN NO EVENT SHALL WOLFSPEED BE LIABLE FOR ANY DAMAGES OF ANY KIND ARISING FROM USE OF THE 
BOARD.  WOLFSPEED’S AGGREGATE LIABILITY IN DAMAGES OR OTHERWISE SHALL IN NO EVENT EXCEED 
THE AMOUNT, IF ANY, RECEIVED BY WOLFSPEED IN EXCHANGE FOR THE BOARD.  IN NO EVENT SHALL 
WOLFSPEED BE LIABLE FOR INCIDENTAL, CONSEQUENTIAL, OR SPECIAL LOSS OR DAMAGES OF ANY KIND, 
HOWEVER CAUSED, OR ANY PUNITIVE, EXEMPLARY, OR OTHER DAMAGES.  NO ACTION, REGARDLESS OF 
FORM, ARISING OUT OF OR IN ANY WAY CONNECTED WITH ANY BOARD FURNISHED BY WOLFSPEED MAY BE 
BROUGHT AGAINST WOLFSPEED MORE THAN ONE (1) YEAR AFTER THE CAUSE OF ACTION ACCRUED.  

INDEMNIFICATION 
The board is not a standard consumer or commercial product. As a result, any indemnification obligations 
imposed upon Wolfspeed by contract with respect to product safety, product liability, or intellectual property 
infringement do not apply to the board. 

https://nam12.safelinks.protection.outlook.com/?url=https%3A%2F%2Fforum.wolfspeed.com%2F&data=05%7C01%7CTina.Ruiz%40wolfspeed.com%7C58184f9c8f8947fda49108dad6ff7139%7Ca326555ee95e4f1b87f747eba52c598e%7C0%7C0%7C638058689844845228%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=XOBjvkgx2BLXHsgObZIz1BllxzaqWAcr%2BB9LzfSZSHw%3D&reserved=0
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